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[bookmark: _Toc42117446]Introduction
These Release Notes describe the new features and changes to the CPRS software that are a part of CPRS GUI version 31b, which includes both a GUI executable and an M patch, OR*3.0*377. Often, there are patches from other VistA packages that accompany a CPRS GUI release in support of the GUI contents or they may provide additional features seen in CPRS. Additional features will be covered in the patch descriptions of those patches. 
CPRS GUI v31b includes new projects, enhancements to existing features, and defect corrections. Projects include System for Mammogram Alerts and Tracking (SMART), Teratogenic Drugs, and Auditing of Copy/Paste Text in Clinical Documents.

Below is a list of all the applications involved in this project along with their patch numbers:
  
   APPLICATION/VERSION				PATCH
   -------------------------------------------------------------------------------------------------------
   KERNEL v8.0					XU*8.0*653
   TOOLKIT v7.3					XT*7.3*142
   TEXT INTEGRATION UTILITIES v1.0		TIU*1.0*290
   WOMEN'S HEALTH v1.0				WV*1.0*24
   HEALTH SUMMARY v2.7			GMTS*2.7*67
   REGISTRATION v5.3				DG*5.3*932
   CLINICAL REMINDERS v2.0			PXRM*2.0*45
   ADVERSE REACTION TRACKING v4.0	GMRA*4.0*53
   CONSULT/REQUEST TRACKING v3.0		GMRC*3.0*88        
   OUTPATIENT PHARMACY v7.0			PSO*7.0*477 
   ORDER ENTRY/RESULTS REPORTING v3.0	OR*3.0*377
 
Patches XU*8.0*653 and XT*7.3*142 are being released in their individual Kernel Installation and Distribution System (KIDS) Host files. The other patches (TIU*1.0*290, WV*1.0*24, GMTS*2.7*67, DG*5.3*932, PXRM*2.0*45, GMRA*4.0*53, GMRC*3.0*88, PSO*7.0*477, and OR*3.0*377) are being released in the KIDS multi-package build, CPRS V31B REQUIRED PATCHES 1.0.
[bookmark: _Toc42117447]Purpose
These release notes cover the changes to CPRS GUI v31b.
[bookmark: _Toc42117448]Audience
This document targets CPRS GUI v31b users and administrators. It applies to the changes made between this release and any previous release for this software.
[bookmark: _Toc42117449]This Release
The following sections provide a summary of the new features and functions, enhancements and modifications to the existing software, and any known issues for CPRS GUI v31b.
[bookmark: _Toc42117450]Non-CPRS Features that Affect CPRS Functionality
Sometimes, changes in other software affect what happens within CPRS. The following change was made in software outside of CPRS and it resulted in a change in CPRS behavior:
[bookmark: _Toc42117451][bookmark: _Hlk22040212][bookmark: _Hlk21684216]PIN Entry Required for Each Controlled Substance Order  
Currently, the provider must enter their Personal Identification Verification (PIV) Personal Identification Number (PIN) to individually sign each Controlled Substance (CS) order. In previous releases, a provider could enter their PIV PIN once to sign multiple CS orders, but that functionality has changed.
To meet the NIST FIPS 201-2 compliance requirement, Microsoft Windows and ActivClient, not CPRS, were updated. Each digital signature request (signature for a CS order) now requires the user to physically interact with their PIV card via their PIN. For example, if providers enter five controlled substance orders, they need to physically interact with their PIV card by entering their PIN five times, once for every CS order. Previously, the provider could sign all five orders by inserting their card and PIN just once.

[bookmark: _Toc42117452]New Features and Functions Added
The following are the new features and functions added to the CPRS GUI v31b release.

[bookmark: _Toc42117453]Enhanced Cover Sheet
The Cover Sheet is greatly enhanced in CPRS v31b GUI. Prior to v31b, the Cover Sheet displayed data in individual panes, but the display order of panes could not be customized, and a pane could only be refreshed when the entire patient chart was refreshed. 




Figure 1: The CPRS Cover Sheet displays a variety of information about a patient. This example shows the Cover Sheet without customization prior to the 31b changes. Sites can now customize which panes display, and the order in which they display.
[image: The CPRS Cover Sheet provider a quick "snapshot" of a patient's overall condition for clinicians. Clinicians can see active problems, allergies, postings, active medications, Clinical reminders, recent lab results, vitals, and appointments, visits, and admissions.]

Several changes will enable users to customize some aspects of the display.
CPRS GUI v31b offers the following changes:
Sites can customize users’ display order for panes on the Cover Sheet (accomplished by a Clinical Application Coordinator (CAC) at site discretion)
Users can update data for individual panes using the refresh button on each pane
Users can minimize and maximize individual panes

With the changes, there are ten possible panes that can be on the Cover Sheet:
Active Problems
Allergies
Postings
Active Medications 
Clinical Reminders 
Recent Lab Results
Vitals
Appointments 
Immunizations 
Women's Health    
The site can determine which panes display (all ten are not necessary) and in what order they display. 
Figure 2: This screenshot shows a Cover Sheet that has been customized and three of the panes have been collapsed. Each of the collapsed panes have a small box with a plus sign that can be used to expand it. In the expanded panes, there is also a refresh icon. Right-clicking on these refresh icons will show some options, such as Refresh, Expand or Collapse, and possibly other options, such as No Known Allergies on the Allergies pane.
[image: This screen capture shows a customized Cover Sheet with some collapsed panels. ]

[bookmark: _Toc42117454]New SMART Features (NSR 20100701)
The System for Mammogram Results Tracking (SMART) project includes several changes in CPRS, including new notifications, new reminder dialogs, and new progress note titles. These changes enable users to better track and respond to important information regarding women’s health, including mammogram results, follow-up, and scheduling. 
[bookmark: _Hlk14256310][bookmark: _Hlk14263402]SMART enhances the ability to track and manage mammography results. SMART creates the ability to link a result notification directly to a documentation template. These templates are specific to the Breast Imaging Reporting and Data System (BIRAD) code, and contain typical next steps in management, links to orders, and the ability to document how and when a patient was notified of their result. The template allows users to view the patient’s last three breast images, regardless of the ordering provider; and to view all data captured in CPRS/VistA related to the patient’s breast care, beginning with when the result was entered into VistA. Once implemented, data from the SMART templates will populate the Breast Care Registry.


[bookmark: _Toc42117455]SMART Alerts
CPRS has added two SMART alerts or notifications:
SMART Abnormal Imaging Results –triggered when SMART specific imaging procedures have abnormal results
SMART Non-Critical Imaging Results –triggered when SMART specific imaging procedures have results that are anything but abnormal
Scheduled Alert –triggered at a future time. This is currently used with the reminder dialog element, VA-TICKLER ELEMENT and is within the SMART reminder dialogs.

[bookmark: _Toc42117456]Deferring Alerts
The new Defer button on the alerts screen enables users to defer an alert up to 14 days at a time. An alert can be deferred until a process purges or deletes the alert. The user can defer anywhere from five minutes to 14 days each time it displays. 

[bookmark: _Toc42117457]New Patient-Centric Notifications View
Under the File menu, CPRS now has an item called View Patient’s Notifications, which enables users to view notifications that relate only to the current patient. Unlike the notifications on the Patient Selection screen that are all for the specific provider, but may be for different patients, the display from the View Patient’s Notifications menu item brings up a dialog for items related only to the selected patient. An example is shown in the next section.


[bookmark: _Toc42117458]Viewing and Processing SMART Notifications
SMART Notifications display on both the Notification screen, the provider-centric display on the bottom of the Patient Selection screen, and the Patient-Centric dialog that displays when the user selects File | View Patient’s Notifications. 
SMART Notifications are all labeled as with SMART at the beginning of the Message text.
Figure 3: The patient selection screen with the notifications for the provider.
[image: ]










Figure 4: The View Patient’s notifications menu item under the File menu.
[image: ]


















Figure 5: The Patient Notifications dialog where the notifications for the currently selected patient are displayed. In this example, one of the SMART notifications displays in the list. New columns include “My To Do” and the “Ordering Provider” and the user can process, defer, or close the dialog. The date range of displayed alerts is also customizable.
[image: ]


Each SMART notification an action alert that takes the user to a template that contains a Reminder dialog. In the Reminder dialog, the user can document the imaging result if the patient was informed and may also be able to focus on follow up or even place orders. Completing the dialog also creates a progress note. 













Figure 6: A reminder dialog that shows the options for documenting imaging results
[image: ]
When completed, each reminder dialog files Health Factors that are monitored in the Clinical Data Warehouse (CDW) by the Breast Cancer Clinical Case Registry (BCCCR). 

[bookmark: _Toc42117459][bookmark: _Hlk17875743]CPRS Women's Health Potentially Unsafe Medications, NSR 20071218
The current version of the VHA's Veterans Health Information Systems and Technology Architecture (VistA) and CPRS software does not inform the provider that an item is teratogenic. Teratogens are drugs (including medications), chemicals, or other exposures, like radiation, that can interfere with normal embryonic/fetal development and thus, may lead to birth defects or pregnancy loss. In addition, there is a group of medications that pose a potential risk to breastfed infants.
The requested enhancements include the following:
· Ability to document a patient’s pregnancy status, intentions related to becoming pregnant (including methods of contraception), and breastfeeding status through both the Cover Sheet tab (using a new Women’s Health pane) and two new clinical reminder dialogs (Pregnancy/Intentions/Contraception and Update Lactation Status).
· Enhanced medication and radiology order checks that consider the patient’s pregnancy status (including likelihood of becoming pregnant) and the patient’s breastfeeding status.
· A new notification to the ordering provider of high-risk medications or radiology orders when a patient’s status changes to pregnant and/or changes to lactating.
· A new notification to the Women’s Health coordinator, ordering provider, and maternity care coordinator when a laboratory test for pregnancy is resulted or an ICD code is added to the patient’s chart, indicating a pregnancy or breastfeeding status that differs from what is documented. When processed, the notification will prompt the user to update the documented status, if appropriate.
· A new VistA notification to the Women’s Health and Maternity Care coordinators when a note associated with a documented pregnancy status or documented lactation status is deleted, retracted, or reassigned. When processed, the notification prompts the user to review the documented status and perform a chart review to ensure that the status is still accurate.
· A new report (Women’s Health: Potentially Unsafe Medications, located in the Clinical Reports -> Pharmacy tree of reports) that lists the high-risk medications (both teratogenic and those that could harm breastfed infants) for female patients.


[bookmark: _Toc42117460]Other Than Honorable (OTH) Functionality (NSR 20170403)
CPRS v31b introduces new components and modifications to support the Other Than Honorable (OTH) functionality for the Suicide High Risk Patient Enhancements (SHRPE) project (NSR 20170403). 
To help address veterans with high risk for suicide, the VA provides two types of eligibility for former servicemembers with Other than Honorable (OTH) discharge types seeking mental health care:
OTH-90 care type, which provides one or more 90-day episodes of care within a 365-day period for those who have an OTH discharge. 
OTH-EXT care type, which provides care with no time limit for those who have an OTH discharge.
Note:    The OTH buttons will display only if patches DG*5.3*952 and DG*5.3*977 are installed and the necessary criteria are met. If those patches are not installed, the OTH button will not display. The OTH-EXT care type will display on the OTH button only if patch DG*5.3*977 is installed.


For the end users, Other Than Honorable changes in CPRS include the OTH button available from any CPRS tab and the dialog that displays when the button is selected. 
[bookmark: _Ref42195705]Figure 7 The OTH button outlined in red for emphasis[image: ]

On the OTH button, the label ‘OTH’ displays, along with how many days remain in the period of care and which period of care the patient is in. The OTH label will display in the following order:
1.  A Number.
2.  The letter “D” for the number of days.
3.  The letter, “P”.
4.  The current period of care. 
The OTH button in Figure 7 displays 36D, meaning that 36 days are remaining in the first 90-day period of care (or ‘P1’).
When the user selects the OTH button, a popup window dialog box displays the same information that displays on the button, including additional information.

Figure 8: CPRS - Patient Chart - Other Than Honorable Status dialog box
[image: ]
[bookmark: _Toc42117461]Copy/Paste - The Ability to Identify and Monitor (NSR 20080528)
Copy/Paste functionality will allow CPRS to capture what text is pasted into Text Integration Utility (TIU) notes. The service will log each instance of pasted text, including where the copy originated, if it can be determined, and when (date/time) the paste actions occurred. The data captured for each Copy/Paste action can be provided for chart and policy reviews, creating an audit trail of paste actions performed on each new document where Copy/Paste actions occur. Copy/Paste actions within the same active document would not be logged as it is assumed that the user is reformatting the document for clarity.
This functionality was designed with flexibility by providing the ability to adjust parameters, add or include/exclude designated note titles or classes, and even disable Copy/Paste tracking (package level), thereby giving system administrators the options they need to customize copy/paste features to the providers’ and sites’ needs.
[bookmark: _Toc42117462]Set Consult TIU Templates as Read-only
This release contains an enhancement that will allow sites to set a TIU template used on a consult request as read-only. This action makes the template and all its associated template fields unavailable for edit – they can be viewed in the editors, but no values may be changed. This enhancement was requested by the Austin FSC Healthcare Claims Processing (HCP) Referral & Authorization System (RAS). RAS depends on specific text elements appearing in certain consult templates. When these templates are modified by a site, the HL7 messaging between RAS and VistA Consults/Request Tracking can be disrupted. 
These templates should not be edited by facilities and as such will be locked during the installation of CPRS GUI v31b. 
In the TIU package, a new System-level parameter, TIU TEMPLATE CONSULT LOCK, has been added that will facilitate the locking. The parameter contains the names of TIU Templates that are associated with consult services. The post-install process of patch TIU*1.0*290 will add to the parameter all templates that are linked to a consult service and also have a NAME beginning with “NON VA CARE HCPS”. This approach was used because some integrated facilities use station identifier suffixes on the consult services/templates.
A new menu option, Set consult templates to read-only [TIU TEMPLATE CONSULT LOCK], has been added to the TIU Template Management Functions [TIU IRM TEMPLATE MGMT] menu. This option allows users to add/remove values (templates) to/from the parameter. Templates that are linked to consult services are the only permissible values.
The data dictionaries for the TIU TEMPLATE (#8927) and TIU TEMPLATE FIELD (#8927.1) files have been updated. A new field, CONSULT LOCK, has been added to each file. This field holds the “YES” value of a given template or template field that has been locked via the parameter.
In Consults, a MailMan error message is generated when there is a communication issue between RAS and VistA. This message has been improved to include the HCPS support mail group as a recipient. In addition, the message body will now include the consult number and facility name from where the consult originated. These new elements will assist HCPS support with more rapid resolution of communication errors.



[bookmark: _Toc42117463]Dietetics: Prevent Previous Active Diet Replacing NPO Order Upon Expire, Discontinue, or Cancel (NSR 20080323)
The dietetics ordering functionality has been modified in order to prevent previous active diet orders replacing Nothing Permitted Orally (NPO) orders upon expiration, DC, or cancellation. The following changes have been made:
The NPO orderable item will be added to the Auto-DC Rules when the patch is installed. With this change, the auto-DC rules will prevent the discontinuation of the NPO diet orders for the following event types:
· Specialty transfer (S)
· OR (O)
· Transfer (T)
and the NPO diet remains intact. When NPO diet orders are attempted to be manually discontinued, the system will prevent that action from being taken and display the dialog box to the user with text “NPO Diet cannot be discontinued”.
The system will block all diet orders from having an Expiration Date/Time when ordered and prevent automatic reinstatement of a previous diet. If a new diet order is desired, it must be ordered to replace the active diet order.
When ordering NPO, if a patient is currently on tube-feeding, the provider is displayed in the dialog box, “The patient currently has an active tubefeeding order <display the current tube-feeding order here>”.
The Cancel Future Order Prompt from the tubefeeding order dialog has been removed. A conversion routine has been created to remove the prompt from any Quick Order. Additionally, Quick Orders will no longer allow the features of Auto Accept or Verify.
Accepting a tubefeeding order will prompt one of two different messages depending on the current diet status of the patient. If there is no existing order, the user will be prompted to enter a new diet order. If an existing diet order is present, the user will be prompted to keep the current diet or enter a new diet order.

[bookmark: _Hlk41311143]Note:	The NSR 20080323 software changes in this patch do not include modification of the active patient diets at the time of the install.
  
  


[bookmark: _Toc42117464]Long Text Informational Alerts
 This new functionality provides the ability to display informational alerts that are longer than the standard character count. Long Text Informational Alerts will display in a pop-up window when processed and provide additional actions for the user to take based on that alert.
[bookmark: _Toc42117465]Order Check History, NSR 20140806
This request updates the mechanism by which order checks are captured and stored, ensuring there is always a history of the event. Storing the order check history will permit data analysis of how many order checks are overridden and how many have resulted in a change to the initial provider's order. Specifically, the changes in this release will capture order check information that was previously not captured, such as when an order entry is abandoned after the user is presented with the order checks, and also when an order is changed and new order checks are performed.

[bookmark: _Toc41333878][bookmark: _Toc42117466]Rehost/Reengineer Primary Care Management Module (PCMM) Work Effort Unique Identifying, NSR 20070415
New capabilities for display/use of PCMM-related data are now available in CPRS GUI. Specific changes included are:
1. A PCMM option added to the Patient List area of the Patient Selection screen.

1. The Source Combinations screen (Tools > Options > List/Teams tab) now includes PCMM as a source option.

1. The Patient Selection Defaults screen (Tools > Options > List/Teams tab > Patient Selection Defaults) now includes PCMM Team as an option for the List Source, and a dropdown list to choose a default PCCM Team.

1.  Source Combinations (Tools > Options > List/Teams tab > Source Combinations) now offers PCMM as a source option.

1. Team Information (Tools > Options > List/Teams tab > Teams Information) has added a checkbox to include PCMM teams with descriptive text indicating that PCMM teams may not be edited via CPRS.



[bookmark: _Toc42117467]Patient Safety Issues
HITPS-0391, 0737, 1172, and 1843: There is a potential for a patient to receive an unintentional diet upon transfer from a service that required an NPO (Nothing Permitted Orally) diet. This may lead to problems such as choking, airway obstruction and respiratory arrest. Several changes were made to the NPO diet order process to prevent auto and manual discontinue of diet orders and to provide better warnings to the user when attempting various discontinue and ordering operations.  

Reference NSR 20080323 and Remedy ticket 210982. Also see HITPS-2308 below for discussion of this issue with sites using the Computrition software.

Resolution: Developers changed the auto-DC rules to prevent the discontinuation of the Nothing Permitted Orally (NPO) diet orders for the following event types:
Specialty transfer (S)
OR (O)
Transfer (T)

HITPS-0454: If two of the Medications Expiring notifications are generated at the same time for the same ordering provider, they are recognized as duplicates and only one is sent. Providers may not recognize that more than one medication may be expiring.
Resolution: When processing notifications for expiring medications, the header text of “Medications, Expiring” on the CPRS GUI Orders tab view is now bolded. Related alerts are deleted when expiring meds are discontinued or renewed.

HITPS-0737, 1534: Time Delay Orders Not Being Released Due to a Multitude of Issues. It was discovered that time delay orders may not be released when they should be due to several possible issues, such as:
The movement event didn't take place.
The movement event was delayed.
A change in the treating specialty. 

Resolution: CPRS GUI Orders tab display was updated to clarify when patients have delayed orders and to prompt providers with the set of orders they would like to view. Reference Remedy Ticket #198146.

[bookmark: _Hlk41323672]HITPS-0853: Complex Outpatient Medication Orders with the “EXCEPT” Conjunction Do Not Accurately “Transfer to Inpatient”
Inpatient orders do not have a feature to support the “EXCEPT” conjunction. In this transfer situation, a patient could receive an over- or under-dosing of medication. 

Resolution: CPRS has been modified to remove the “EXCEPT” conjunction from the “then/and” column when entering Complex medication orders.

HITPS-1134: Confusion when Writing Delayed Orders
The help text statement displayed in the Release Order pop up window is confusing and may possibly contribute to duplicate orders displaying after staff manually release inappropriate delayed orders. 

Resolution: When writing Delayed Orders, the Release Orders window has been updated with text that is easier to understand. Additional help text/options have been created to assist users in completing this task. 

Reference Remedy ticket 320527.

HITPS-1471: Copy/Paste
NSR 20080528 is implemented in this version of CPRS. 

Resolution: The ability to identify and monitor copied and pasted text into the medical chart is now available.

HITPS-1546: PCMM Updates 
In CPRS v28, when an inpatient record is opened in CPRS GUI, the PCMM button display was updated to include the patient's Associate Provider. The display of Primary Care, Associate, and Attending providers on the button was confusing.

Resolution: Developers made changes to support Patient Care Management Module Web (PCMM Web). PCMM teams are now available as a patient list on the CPRS Patient Selection screen. It can also be set up as a combination source and a default list for users. Additionally, the display on the PCMM or Patient Care button was changed slightly. For an outpatient, the information is listed on one line: the PCMM team, the Primary Provider, and then the Associate Provider. For an inpatient, the first line is the same, but another line is for the Inpatient Attending and the Provider.

HITPS-1590: Allow Greater than 90 days Supply on Outpatient Meds
New long acting formulations of medications have come onto the market and been added to VHA formulary. Providers need to be able to enter a greater than 90-days supply on medications that only come in units designed to last more than 90 days.  This will require multiple packages to correct.  For example, “Eligard” is a depot injectable that is administered every 180 days. Patient may receive a dose too often with current functionality.

Resolution: VistA Pharmacy and CPRS GUI have been updated to allow medication orders with a maximum days supply of greater than 90 days.

HITPS-1819: Accidental Selection of Wrong Patient
When selecting a patient in CPRS GUI, it is possible to accidentally select the wrong patient due to the selection window “automatically” scrolling. 

Resolution: CPRS GUI was updated to prevent scrollbars from appearing in the patient selection window which will prevent the automatic scrolling.
  
HITPS-1855: Note Corruption on Signature
An addendum added by an additional signer to a consult-resulted progress note may get corrupted upon signature, causing the addendum to be unsigned, detached from the parent, and removed from the display.  It may also scramble the parent note's signature. 

Resolution: An issue that caused the addendum to become saved without a document type has been corrected. This is the cause of the scrambled signature. Reference Remedy ticket 594883.

HITPS-1922: Problem Forwarding Consult - Selection Jumps to Different Service
In the Forward Consult window of CPRS GUI, when attempting to select the last service from the drop-down list, it is possible for the selection to “jump” to an incorrect service. The user may not realize that the incorrect service was selected. 

Resolution: This issue has now been corrected. 

Reference Remedy tickets 594883 and 1051196.

HITPS-1931: Tooltip not Updating on Problem List of Encounter Form
On the CPRS Encounter form, the tooltip is not always updating to the correct item. On the Problems tab of the Encounter form, when the form size is reduced in order to generate a scrollbar and the mouse hovers over a problem in the list, a tooltip is generated. When the mouse is moved to other items in the list, the tooltip remains unchanged from the initial item. 

Resolution: The tooltip will now change as the mouse is moved to different items in the list. This resolution also addresses other tickets: tickets 394902, 536815, and R6418568FY16.

HITPS-2117, 2147, and 2215: When a patient from a site with the Computrition software is ordered a tubefeeding and is not ordered a SEND NO TRAY “diet” at the same time, a  previously ordered diet without an expiration date will automatically  reinstate, without notification to dietary staff or the healthcare provider. Reference HITPS-0391 for measures taken in CPRS GUI to mitigate downstream issues in the Computrition software.
  
HITPS-2298: CPRS Cover Sheet Immunization Display
The Cover Sheet Immunization display area displays the Short Name of the immunization. For example, Pneumococcal PPSV23 vaccination displays as “Pneumococcal”, which may lead to a provider thinking PCV13 was given. 

Resolution: CPRS Cover Sheet will now display the full name of the immunization instead of the short name (i.e. “Pneumococcal Polysaccharide Ppv23” instead of “Pneumovax”). Reference SDM ticket R10995796FY17. 

Note: There is one remaining issue to completely correct the Log Name issue and it will be released in OR*3*498.
  
HITPS-2308 and 2425: A Manual or Auto-discontinued NPO Diet in CPRS can Cause a Previously Ordered Diet to Reinstate in Computrition 
NPO diets in Computrition can revert to the previous diet order upon auto or manual discontinuation in CPRS, without any notification to the dietary staff or healthcare provider. This occurs because the discontinuation of the NPO diet in CPRS is communicated to Computrition. Because Computrition always expects a diet for a patient, it automatically reinstates the most recent previously ordered active Computrition diet. When this issue occurs, CPRS will also automatically reinstate the most recent previously ordered diet. Because of this, the diet listed in CPRS and the diet listed in Computrition may be completely different (and it is possible the patient should have remained on the NPO diet). 

Resolution: The updates to CPRS GUI/VistA described in HITPS-0391 above are intended to mitigate the possibility of downstream issues in Computrition.
  
HITPS-2313: Autosave of Progress Note
The progress note autosave functionality is not working in CPRS versions 30b (OR*3*350) and 30c (OR*3*423) under certain circumstances. This issue is only apparent when there is an abnormal termination of the CPRS session, AND the user has NOT saved the progress note without signature or signed the progress note. One example of an abnormal termination of the CPRS session is when the user invokes Windows Task Manager to End that Process. 

Resolution: CPRS GUI has now been corrected to restore the autosave of TIU notes in this scenario.
  
HITPS-2251, 2260, and 2316: Patient Data Objects Incorrectly Listed Clinic Order as an Active Inpatient Order
Nationally exported TIU Patient Data Objects (PDOs) that display patient medication information did not distinguish Clinic Medications/Infusions from other medications. 

Resolution: The rules for medication object PDOs have been updated to either remove Clinic Medications from the display or place Clinic Medications in their own sub-heading. Reference CA SDM ticket R9635898FY16.
See TIU*1*290 and the TIU Technical Manual for additional details.
  
HITPS-2367: Skin Test Health Summary Component Display of Reading Values
Skin test Health Summary components readings in CPRS are displayed as “0 mm” when the purified protein derivative (PPD) skin test was given, yet not read. Providers interpreted this as a negative reading, when actually, no reading should display, and Results should state “UNREPORTED”. 

Resolution: The Reading field on the Skin Test tab of the CPRS GUI Encounter form has been updated. This field now has a drop-down list to enter skin test reading values and the field will no longer default to a zero value. The default zero value was the root cause of the misleading display in the Health Summary components. Reference CA SDM ticket R10995796FY17

· HITPS-2387 - Provider unable to renew outpatient prescription in CPRS, receive LPack error during order checking.

Resolution: The Kernel Infrastructure team modified the broker code to expand the size of the messages that can be sent between the VistA server and the CPRS GUI. This change should accommodate the current needs plus room for future expansion.
 
· HITPS 2482, 6617, 6618, and 6619 - Radiology orders are getting rejected for several reasons: urgency field not being populated, invalid reason for study, invalid request date, and missing reason for study.

Resolution: Changes were made to validate the required fields prior to the order being signed. In addition, updates were made to the handling of quick orders to correct issues uncovered during testing. Changes will be made in OR*3*498 to address the copying of potentially problematic orders.


[bookmark: _Toc42117468]Defect Tracking System Items
INC000000067447 HIN-0102-41933  Review/Sign Changes Asks Nature Of Order For Health Factor
Problem: The Sign/Don't Sign button on Review/Sign changes dialog was not always displaying the correct label under all circumstances.
 
Resolution: Dialog logic was updated to display the correct Sign/Don't Sign label under all use cases.
 
 
INC000000069287  PAL-0600-62575  Order Set Doesn't Work right
Problem: Order Set is not displaying correctly. In some situations while using an order set, the user is able to cancel out of the set without any warning, leaving orders that would need to be discontinued before re-running the order set again.
 
Resolution: A warning message is now presented when clicking on the “Done” button from 
the order set menu.
 
 
INC000000069337  FAR-1100-41820  PPD Reminder Dialog does not send over a 0 reading
Problem: Dialog progress note text is not displaying PPD skin test reading in mm when completed.
 
Resolution: Code modified to allow user to enter a value including a zero reading.
 
 
INC000000069685  HIN-0302-41180  MISSING ERROR WHEN LINK REMINDER DIALOG TO CONSULT REQUEST
 Problem: Error message is not displaying when a user attempts to link a reminder dialog to a consult/procedure.
 
Resolution: The system will now prevent users from being able to move reminder dialogs over to a consult/procedure reason for request.
 
INC000000069758  4 UNY-0502-12261  Dose/Draw times inappropriate/incorrect
Problem: Accessions/orders with missing or incorrect dose/draw times in lab file 60. When moving off of the date boxes in the labs tab, the date box will become blank if a previous date & time were already present in the box.
 
Resolution:  The date & time are now properly formatted so that the conversion to FileMan date & time does not fail.
 
INC000000070504  PUG-0104-51406  Rem dialogs not respecting indent of W-P temp field
Problem: Reminder dialogs not respecting the properties of the template field when configured in a reminder dialog element. 
 
Resolution: Dialogs will now reflect correct formatting and indentions.
 
 
INC000000133674 Problem with Edit/Resubmit in CPRS.
Problem: When a provider orders a consult (not tracking only), the consult user then forwards this consult to a tracking only consult. Then the consult user cancels the consult. If the provider comes back in and tries to resubmit the consult, when the provider tries to accept, the provider is confronted with a “list index out of bounds” error.
 
Resolution: Users will now see the entire list of services when attempting to Edit/Resubmit a non-tracking consult.
 
 
INC000000198146 (HITPS-0737)
Problem: It was discovered that time delay orders may not be released when they should due to several possible issues such as:
The movement event didn't take place.
The movement event was delayed.
A change in the treating specialty.
  
Resolution: In CPRS GUI, if the patient has delayed orders and the user accesses the Orders tab, a dialog window opens labeled “Delayed Orders Exist for this Patient”. This dialog contains the list of the order “sets” available for the patient. The user must choose which set of orders to access.


INC000000198536 Blank Orders
Problem: CPRS is allowing a user to copy an existing blank Text Order. When a text order is initiated and then edited to remove all text, the order can still be signed.  The result is the release of a blank text order which can then be copied into a new blank order.
 
Resolution: Because this problem was caused by leading and trailing spaces, the text is now rimmed to ensure that no extra spaces would be present and cause this issue.
 
 
INC000000205811 Name not being capitalized in Primary Care Team/Provider dialog box
Problem: Name not being capitalized in Primary Care Team/Provider dialog box. 
 
Resolution: Additional characters have been added to the mix character functionality.
 
 
INC000000210982 (HITPS-0391, 0751, 1172, 1843) Auto-DC rules changed to prevent discontinuation of NPO diet orders for the Specialty transfer (S), OR (O), Transfer (T) event types
Problem: Auto-DC rules permit discontinuation of NPO diet orders for the Specialty transfer (S), OR (O), Transfer (T) event types 
  
Resolution: 
Prevent manual DC of NPO diet orders in CPRS GUI and display informational dialog with the reason the action is prevented.
Disallow all Outpatient diet orders to have an Expiration Date/Time when ordered.
When ordering NPO, if the patient is currently on tubefeeding, display dialog to the provider stating as much with CANCEL and CONTINUE options.
Removed “Cancel Future Tray Orders” text and checkbox from tubefeeding order dialog.
Removed “Auto Accept” and “Verify” options from Quick Orders.
Add a dialog box after tubefeeding is accepted, with the following information and two options:

“A tubefeeding order must also have an active diet order”
       “CONTINUE current diet order (in addition to tubefeeding order) 
         <Display current diet order or the text “No Order”>
         and <Display FUTURE diet orders>”

       “Order new diet order (includes NPO diet) in addition to 
         tubefeeding order”. This option would take the user to the diet
         tab of the DIET ORDER order dialog.

INC000000214447 Quantity/Days Supply issues when entering an Outpatient Order
Problem: Outpatient Pharmacy calculation of default Quantities and Days' Supply for a complex order are not returning the Pharmacy API to CPRS for the Quantity calculation when an edit is made to the day's supply field.
 
Resolution: Ensure that the fields are re-calculated as changes are applied to them.
 
 
INC000000215908 Menus in order set automatically moving to next screen
Problem: Menus in order set are automatically moving to next screen. 
 
Resolution: When processing from an order menu from within an order set, the user is now returned to the menu to perform any additional orders before moving to the next part of the order set. 
 
 
INC000000221092 “stacked” alerts
Problem: When processing “stacker alerts” for a patient, the alerts are all pointing to the same action so that when they are processed, the system is not processing the correct one. 

Resolution: When processing alerts, ensure that the correct alert action is being processed.
 
 
INC000000240130  VAMHCS - TIU*1*222 printing issue
Problem: Work Copy print option for a Windows default printer displays Social Security Number and Date of Birth and does not allow user to change to Chart Copy.  If the default printer is set to a VISTA printer, users have the option to choose between Work and Chart copies.
 
Resolution: Users will now always get the dialog to choose chart or work copy as well as a VistA printer.
 
INC000000245545 Can copy an order with an inactive drug
  
Problem: CPRS allows an outpatient medication order to be copied even when the drug has been made inactive or has since been marked that it is not for outpatient med use. This can occur if there is more than one drug linked to the orderable item, and one of the drugs is still active and marked for outpatient use.
  
Resolution: When copying an outpatient medication order, check the drug on the prescription, and if it is not active or not marked for outpatient use, do not allow it to be copied.

 
INC000000301412 “No Report Generated” warning not clearing between tabs
Problem: “No Report Generated” warning not clearing between tabs. 
 
Resolution: Developers made a logic change to clear the warning when switching to a 
new tab.
 
 
INC000000305468 Users getting kicked out of CPRS with access violations
Problem: Users getting kicked out of CPRS with access violations and other errors when entering notes and orders.
 
Resolution: Gracefully close modal dialogs when CPRS times out or loses connection.
 
 

INC000000319910 Marking SHAD for encounters
 
Problem: On the Encounter form, the SHAD condition is dependent on the Service Connection (SC) box being checked.
 
Resolution: Developers made a change in CPRS to remove the dependency between SHAD and SC.
 
 
INC000000320527 Delayed Orders instruction confusion
Problem: When a user selects the Write Delayed Orders button to use delayed orders for an inpatient transfer, the instructions are unclear, causing users to think the order is cancelled rather than the Hold being cancelled.
 
Resolution: When writing Delayed Orders, the Release Orders window has been updated. The “Event Delay List” text has been replaced with “Delay Orders Until”. A single radio button is present on the window with the text: “Delay release of new order(s) until”. And two new parameters have been added that can be used to add descriptive help text within the form itself and to launch (via button click on the form) a site-defined webpage for additional information/help with writing delayed orders.
 
 
INC000000328153 Need to add logging capability into CPRS.
Problem: There is a need for logging capability in CPRS to assist with debugging and correcting exceptions (access violations, etc.) and runtime errors (Stack overflow error, etc.)
 
Resolution: Developers added a parameter and additional coding to allow CPRS logging to be turned on/off.
 
 
[bookmark: _Hlk41329299]INC000000394902 Diagnosis form problem.
Problem: In some instances, when you select a diagnosis on the encounter form, it shifts the row down and selects a choice higher up on the list.
 
Resolution: Developers corrected this issue. This item is a duplicate of ticket R6418568FY16 and was addressed in conjunction with work on HITPS-1931.
 
 
INC000000433206 AP reports from another VA showing up in patient CPRS record
Problem: The ORWRP CIRN AUTOMATIC parameter determines if remote patient data queries are done for all sites.  In this case, the parameter was turned on which led the user to see AP reports from another facility.  However, it was found that CPRS was not correctly implementing the parameter value and would only select the first site in the list instead of all sites.
 
Resolution: Developers made a change to CPRS such that when the ORWRP CIRN AUTOMATIC is turned on, “All Available Sites” from which remote data can be retrieved will be checked.
 
 
INC000000434226 When Surgery tab is selected for a certain patient, the user gets an invalid index error
Problem: CPRS would sometimes “hang” on loading the Surgery tab for certain patients.
 
Resolution: Developers made changes to the Surgery tab logic to prevent the error.
 
 
INC000000443011 Encounter Pop-Up Box Not Appearing with Flu Reminder as Secondary Diagnosis
Problem: Providers are not being prompted to enter primary diagnosis codes when a nurse has documented a flu vaccine on the primary care visit via the clinical reminder. The nurse documentation includes a secondary diagnosis only.  
 
Resolution: If primary diagnosis is not present, then add this to the popup informing the user that it is needed.
 
 
INC000000450139 Pt name on reminder definition in CPRS
Problem: Patient name prints on reminder definition when printing from CPRS/Reminder Inquiry.  Patient name should be suppressed due to potential breach of patient privacy.
 
Resolution: Set a flag to determine if the header should print or not.
 
  
I13413770FY17  Non-VA Meds & Additional Diet orders NOT releasing v28
Problem: Non-VA meds are not showing up in notifications when closing CPRS, refreshing the patient or selecting a new patient.
 
Resolution: Unsigned order notifications are only removed when both the signature and the order check (if applicable) have been completed.


INC000000482781 V28 Release from Hold Action
Problem: Hold action messages for medications are causing confusion when removing the Hold and needs to be reworded in both Pharmacy and CPRS.
 
Resolution: Changed code to force action to respect parameter.
 
 


INC000000536815 PCE software/issue
Problem: Entry of a secondary diagnosis to an encounter form in CPRS is not stuffed when selected from the miscellaneous list if the list is long enough to require the user to scroll. Also addresses INC000000394902 and R6418568FY16.
  
Resolution: Users will see that scrolling now puts the box around what is actually behind the mouse.
 
 
INC000000583563  Inactive Dietary Tube Feed Quick Order still functions
Problem: Inactive Dietary Tube Feed Quick Order still functions even though the tube feeding entry has been “inactivated”, and there is no indication to the provider that the entry is inactive.
 
Resolution: A message will now display to the user that the orderable is inactive and the dialog will not open.
 
 
INC000000603534 A note title association got somehow LINKED to the ROOT folder “Document Titles”.
Problem: A note title association was inappropriately LINKED to the ROOT folder “Document Titles”, resulting in the ‘associated title’ field for all note titles not displaying. 
 
Resolution: Developers enabled the CPRS GUI Template Editor to prevent linking note titles to the root folders.
 
 
INC000000444608 Discharge Summary - Attending Physician
Problem: In a Discharge Summary, use of the Identify Additional Signer (Right Click) to change the Expected Cosigner allows a user without Expected Cosigner credentials to be selected as the Expected Cosigner. If an author selects Attending Physician prior to selecting Discharge Summary Title, Residents are not displayed. Also, once a Discharge Summary is being edited, the Change button displays the Residents under the Attending Physician field. 
 
Resolution: Users will now have only users that are appropriately designated as Expected Co-Signers.
 
 
[bookmark: _Hlk41330190]INC000000594883: scrambled signature block
Problem: There was a problem where the signature block could be scrambled. 
 
Resolution: This was corrected in conjunction with the work done on HITPS-1922.
 
 


INC000000853662  OERR - Orders Tab
Problem: Message box for entry of delayed orders generates a warning that patient is already admitted when the release orders box opens and the “OK” button cannot be selected to exit the message.
 
Resolution: Users will now be able to move the mouse so that the OK button is selectable, and the message/hint window will be hidden when not appropriate.
 
  
INC000001051196 (HITPS-1922) Problem Forwarding Consult - Selection Jumps to Different Service

Problem: In the Forward Consult window of CPRS GUI, when attempting to select the last service from the drop-down list, it is possible for the selection to “jump” to an incorrect service. The user may not realize that the incorrect service was selected. 
  
Resolution: The service list display has been updated to prevent the incorrect selection from occurring.


 Restrict One-Step Clinic Administration Menu
Problem: There is a need to restrict the One-Step Clinic Administration menu item on the Action menu of the Orders Tab using a site-configurable parameter.
 
Resolution: A new parameter has been created called OR ONE STEP CLINIC ADMIN OFF. This parameter is used to disable/enable the “One Step Clinic Admin” option on the Action menu on the ORDERS Tab. This parameter is exported with a Package level default set to NO, which leaves the “One Step Clinic Admin” menu item on the Action menu of the ORDERS tab active/selectable. Setting this parameter at the System, Division, or User level to YES will make this menu inactive/unselectable.


R6418568FY16: CPRS Encounter Issue – Problem selecting appropriate diagnosis
Problem: A provider is having trouble when he is entering a Diagnosis in the Encounters. Multiple times he attempts to click on a current problem to update ICD-10 and the screen shifts. There are times he thinks he is on the appropriate/selected diagnosis, only to find out he has changed another diagnosis. This has been a long running problem. It seems to happen when there is a veteran that has more diagnoses and there is a scroll bar to the right side.
  
Resolution: Developers corrected this issue. This was corrected along with work for HITPS-1931 and is a duplicate of Remedy 536815.


I7439454FY16: Lab Order Discontinue Issue
Problem: Lab orders are not eligible for canceling or discontinuing after the orders are accessioned in the Laboratory package. The accessioning process indicates that labels have printed, and testing may have begun on the specimen. However, it is possible to discontinue a Lab order after accessioning if accessioning occurs between the time the order was specified to be discontinued in CPRS and the time the discontinue was signed in CPRS. Also, addresses INC4466842.
  
Resolution: Modify routine ORCACT01 to perform a check as to whether an order was accessioned before allowing the user to sign a discontinue in CPRS. The following message will display: “This order may not be discontinued. Cancel the discontinue to remove it from the patient's record.” Sites may add additional text to the message (i.e. listing a phone number to call for assistance) by defining text for the parameter “OR LAB CANCEL ERROR MESSAGE”.


I10799607FY16, I9235462FY16, I8633754FY16, I14165711FY17 CPRS crashes with certain order sets
Problem: In certain cases, CPRS will abnormally terminate when executing certain order sets/menus.
  
Resolution: Even though this problem is easily reproduced in v30c and v31a, it can no longer be recreated in v31b. Unfortunately, there was no specific project or task that was started to address this issue. It is being included in testing for 31b to verify that it is resolved.
  

[bookmark: _Hlk41330745]R9635898FY16 (HITPS-2251, 2260, 2316) Missing data objects - CPRS update
Problem: Nationally exported TIU Patient Data Objects (PDOs) that display patient medication information did not distinguish Clinic Medications/Infusions from other medications.  

Resolution: The rules for medication object PDOs have been updated as follows:
Clinic medications are no longer grouped with Inpatient medications. An object that only displays inpatient medications will no longer display any clinic medications.
Existing objects that currently display both inpatient and outpatient medications will now display clinic medications in their own sub-heading. 

National PDOs affected are:
ACTIVE MEDICATIONS
ACTIVE MEDS COMBINED
DETAILED ACTIVE MEDS
DETAILED RECENT MEDS
RECENT MEDICATIONS
RECENT MEDS COMBINED
  
Any locally created TIU PDO calling the LIST^TIULMED API is affected by this update.
  

R10995796FY17 (HITPS-2298) CPRS Coversheet immunization display issue due to Immunization Short Name – Patient Safety Issue reported
Problem: CPRS Cover Sheet Immunization area displays the Short Name of the Immunization. For example, Pneumococcal PPSV23 vaccination displays as “Pneumococcal” on the CPRS coversheet, which may lead to a provider thinking PCV13 was given.
  
Resolution: CPRS Cover Sheet will now display the full name of the immunization instead of the short name (i.e. “Pneumococcal Polysaccharide Ppv23” instead of “Pneumovax”).
  

I16877892FY18 Problem with messages after OR*3*461 released 
Problem: Post Patch OR*3*461 fixing generic orders and sending FORUM messages, these are NOT medication orders. Currently, the post patch process requires someone from CLIN 2 processing all of these FORUM messages. As of today, there have been 2189 generic orders being identified where the TO field was changed by OR*3*461. There have been about 343 messages for PSJ OR PAT OE related medications fixed and 30 PSJ OR CLINIC medications fixed.
  
Resolution: The audit code, created in OR*3*461, to assist in tracking down display group issues has been modified to ignore generic (nurse, text, activity, etc.) orders that are associated with the Inpatient Meds display group.

I17427419FY18: BCMA Radio Buttons not properly displaying warning messages
Problem: When the user selects a radio button for an invalid report range, an error is displayed (“The Date Range selected is greater than the Maximum Days Allowed of 7 for this report.”), but only the first time. After that, selecting a new date range button will not update the report nor inform the user of an incorrect choice.
  
Resolution: The CPRS GUI was not clearing the 'button click' after processing. The GUI was modified to clear after processing each time. Therefore, the error message will display each time an inappropriate selection is made.
  

I16805536FY18: Receiving access violations daily.
Problem: When looking up a diagnosis in the “Lookup Other Diagnosis” form, if the user double-clicks on the white space next to a search result when no search result has yet been selected, there is an access violation.
  
Resolution: The double-click handler for the search results now checks to make sure something is selected (and is not nil).
  

  



I18660001FY18 Error in ORQPTQ5
Problem: When the provider attempted to log in to CPRS, there was an immediate M error in routine ORQPTQ5.
  
Resolution: The error was related to having a patient selection list that contained over 200 appointments plus a particular combination of selection list parameters, as well as only future appointments no more than one day in the future. Modified the routine ORQPTQ5 to handle this particular situation.
  

I18906933FY18 - CPRS GUI Access Violations when user selected a patient and, in another case, when she processed an alert
Problem: When the connection the Vista server is slow enough, it's possible for the CPRS user to click on “File, Select New Patient...” multiple times before the server responds. This can create a situation where opening the Select Patient form from the first menu click is interrupted in mid-setup by the second. The error won’t happen, though, until the Select Patient form is closed by selecting a patient or processing an alert. The interrupted attempt tries to restart, and fails, creating an access violation.
  
Resolution: The call to “Application.ProcessMessages” in ResizeDescendants in ORFn.pas has been removed to prevent a possible attempt to open the Select Patient form a second time while it is already being opened.
  

INC000000914776 (HITPS-1819) Patient selection screen issue 
Problem: When selecting a patient in CPRS GUI, it is possible to accidentally select the wrong patient due to the selection window “automatically” scrolling. 

Resolution: CPRS GUI was updated to prevent scrollbars from appearing in the patient selection window, which will prevent the automatic scrolling.
  

I6910726FY16 Display Issue in CPRS for IV Order
Problem: Initially, the problem being reported was that the Total Dose display in the Order Detail for IV orders displayed different values depending on whether or not the finishing pharmacist had auto-verify turned on or off in the Pharmacy package.
  
Further investigation revealed that, in fact, the Total Dose was ambiguous for IV orders, in general. The best example is a multi-additive IV order. Total Dose has no meaning.
  
Resolution: Per the decision of the Pharmacy Benefits Management group, Total Dose has been moved from the Order Detail display for IV orders. It will remain for Unit Dose medications.
  



I7705227FY16 - Pharmacy Quick Orders
Problem: The message, “Instructions may not be longer than 60 characters”, prevents the entering of a quick order.  This message is encountered when local dosage instructions are over 60 characters and BCMA UNITS are defined.
  
Resolution: Modify routine ORCDPS2 to use the “D” index in the local ORDIALOG array instead of the “B” index. The “D” index contains the local dosage instructions without the BCMA amount. The “B” index included the BCMA amount and was the reason the condition failed displaying the message and preventing the completion of the quick order.
  

INC0419622 - RA OERR EXAM Menu does not allow user to scroll through all exams
Problem: A provider could not locate an U/S Thyroid order. It was found that the user can only scroll through part of the list using the mouse. About halfway through, it stops scrolling. Users either need to select one of the exams and use the arrow keys on the keyboard to continue scrolling or type the exact name of the test.
  
The problem stems from how the component attempts to cache the value of the “page size” of the visible listbox. The cached value is incorrect, calculated against a 0-pixel height, which causes the scrolling to behave erratically.
  
Resolution: Instead of relying on the cached value of the “page size,” the “page size” is calculated based on the control's current height just before the value is needed. Since the calculation is simple (FLargeChange := (Height div ItemHeight) - 1), caching isn't required.

INC0000002148685 - RTC Order Cancellation IEN issue
Problem: In CPRS, Orders tab, enter a "Return to Clinic" order, when the user selects the return date, types in the name of the clinic (not using the dropdown list), then clicks on "Accept" without tabbing out of the clinic field/editbox, the clinic name isn't being saved.

Resolution:
The clinic field/editbox automatically verifies the typed in clinic name against the list and properly records it in the order.

I19275515FY18 - VistaWeb button label issue in CPRS
Problem: The remote site selection panel does not respect certain acronyms and
coverts them to proper case.

Resolution: GUI was modified to better respect acronyms. A new parameter (OR EXCLUDE
FROM MIXCASE) was created to allow new acronyms to be added “on the fly”
to the CPRS GUI.

[bookmark: _Toc42117469]Known Issues
N/A

[bookmark: _Toc42117470][bookmark: _Hlk520890296]New Parameters
CPRS v31b has several new parameters from different packages: CPRS (parameters that start with OR), Consults, TIU and Women’s Health.
[bookmark: _Toc42117471]CPRS Parameters
OR CPRS EXCEPTION EMAIL
OR CPRS EXCEPTION LOGGER
OR CPRS EXCEPTION PURGE
OR CPRS HELP DESK TEXT
OR EXCLUDE FROM MIXCASE
OR LAB CANCEL ERROR MESSAGE
OR ONE STEP CLINIC ADMIN OFF
OR RELEASE FORM HELP
OR RELEASE FORM TEXT
OR SD CIDC STOP OFFSET
OR SD DIALOG PREREQ
ORCH CONTEXT MEDS INPAT
ORCH CONTEXT MEDS OUTPAT NONVA
ORLP DEFAULT PCMM TEAM
ORLP DEFAULT PXMM TEAM
ORLP TEAM LIST FROM REM
ORLP TEAM LIST FROM REM FREQ
ORLP TEAM LIST FROM REM LAST
ORLP TEAM LIST FROM REM OVER
ORQQTIU COPY/PASTE EXCLUDE APP
ORQQTIU COPY/PASTE IDENT
ORWCV1 COVERSHEET LIST

[bookmark: _Toc42117472]Consults Parameters
GMRC FSC HCP MAIL GROUP

[bookmark: _Toc42117473]TIU Parameters
TIU TEMPLATE CONSULT LOCK

[bookmark: _Toc42117474]Women’s Health Parameters
WV COVER SHEET WEBSITES
WV ENTERED IN ERROR REASONS
WV IMAGING ORDER START DT
WV TIU ANCILLARY DATA MESSAGE

[bookmark: _Toc42117475]Modified Parameters
CPRS v31b has modified several existing parameters. 
· OR SD ADDITIONAL INFORMATION
· OR SD DIALOG PREREQ
· ORWCV1 COVERSHEET LIST

[bookmark: _Toc42117476]Product Documentation
The following documents apply to this release:
CPRS User Guide: GUI Version
CPRS Technical Manual: GUI Version
CPRS GUI v31b Release Notes (this document)
CPRS GUI v31b Deployment, Installation, Back Out and Roll Back Guide
CPRS Set Up and Configuration Guide
Online Help System

CPRS v31B Patch Description Changes
After release of the CPRS v31B series of patches, needed changes were identified in the patch descriptions.
PSO*7*477
PSO*7*477 contained a list of updated documents included in the release. However, the file names were incorrect. The corrected file names are included in this patch description.
Corrected file names:
Title				File Name			Transfer Mode
-------------------------------------------------------------------------------------------------
Outpatient Pharmacy -		PSO_7_MAN_UM.DOCX	Binary
  Manager's User Manual	PSO_7_MAN_UM.PDF	Binary
Outpatient Pharmacy -		PSO_7_PHAR_UM.DOCX	Binary
  Pharmacist's User Manual         PSO_7_PHAR_UM.PDF	Binary
Outpatient Pharmacy -		PSO_7_SUP_UM.DOC		Binary
  Supplemental User Manual	PSO_7_SUP_UM.PDF		Binary
Outpatient Pharmacy -		PSO_7_TECH_UM.DOCX	Binary
  Technician's User Manual	PSO_7_TECH_UM.PDF	Binary

OR*3*377
In the OR*3*377 patch description, the after patch checksum for ORY377 was incorrect. The patch description expected value is 43125694. The actual value should be 43196520.

OR*3*377 contained a list of updated documents as well as source files distributed. Three of those names were changed and the patch description wasn’t updated.

The corrected names are below:
File Name				Contents		
OR_3_0_377_RN.PDF		CPRS GUI v.31 (Patch OR*3.0*377) Release Notes
CPRSV31B_REQUIRED.KID	CPRS v31B multi-package build
CPRS_31_Help.ZIP			This file is not distributed in an individual ZIP file.
					The HELP folder is now contained in OR_30_377.ZIP.

PXRM*2*45
1. The Files & Fields Associated section missed a file that is distributed in the patch.
2. The Patch Installation section is incomplete and outdated. That section is deleted in its entirety and replaced. See below for the additional and replacement text.

Updated sections:

File Name (Number)          Field Name (Number)       New/Modified/Deleted
------------------          -------------------       --------------------
REMINDER ORDER CHECK RULE                             No Change
  (#801.1) 

Patch Installation:
-------------------
  
Pre/Post Installation Overview:
The environment check routine verifies that both Clinical Reminders Update
54 VA-Teratogenic Medications Order Checks (Update #4) and Update 16 
VA-WH Mammogram Screening content update is installed. Installation of 
this patch will not proceed if these exchange entries are not installed. 
The installation manuals for both updates are available on the VA Software
Documentation Library.
 
It is important to note that the CPRS v31b Deployment, Installation, Back 
Out and Rollback Guide also refers you to a CPRS v31b Configuration and 
Setup Guide. This guide provides instructions for both pre and post 
install items that must be completed. 
 
 
 
Installation Instructions:
Please refer to the "CPRS v31b Deployment, Installation, Back Out and 
Rollback Guide" for installation and set-up information. This document is 
exported as or_3_0_377_dibr.docx and or_3_0_377_dibr.pdf and is included
in OR_30_377.ZIP and will be emailed to the installation points of contact
by the CPRS Implementation team.
 
Installation of these host files must be coordinated among the personnel 
affected because these host files will be installed in one installation 
session.
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